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Introduction

Welcome to the IIFL Trader Terminal.

IIFL Trader Terminal is a comprehensive trading tool, with superior charting and
analytical capabilities. The latest version of the Trader Terminal has a lightning fast
execution speed, world class user interface and a single?click access to our world?class
research. The new terminal offers the facility to trade in cash, derivatives, mutual funds,
IPOs, currencies and commodities, all in one screen.

On this trading platform you can conveniently trade on the following four Indian
Exchanges:

1. National Stock Exchange (NSE)

2. Bombay Stock Exchange (BSE)

3. MCX

4. NCDEX

Key features of the Trader Terminal are:

¢ Streaming quotes, instant order confirmation, multiple market watches, alerts
*  Single-click access to depository, ledger, MTM profit/loss statement

¢ Advanced charting options & technical analysis tools

¢ Customizable view

¢ Live-chat with customer care

¢ Live research and news updates

¢ Accessible from the desktop, over the web as well as mobile phones

T3 (DE/? Manual



IIFL

How do I access the IIFL Trader Terminal?

Installation of IIFL Trader Terminal is a very simple process.

¢ Download the application from the following link and then install:
http:/ /content.indiainfoline.com/IIFLTT/EXE /IIFLTTClient.msi

* To access the terminal on web:
http:/ / ttweb.indiainfoline.com

* To access the terminal on mobile use the following link:
http:/ /ttm.indiainfoline.com

System Requirements

The IIFL Trader Terminal is optimized for use with a modem and an ordinary internet
connection. However, please check that your personal computer satisfies the following
requirements:

Operating system

The software is tested to work on Windows 98, Windows 2000, Windows 2003,
Windows NT, Windows XP, Windows Vista and Windows 7. On Windows 2000, NT
and 98 you will have to download .NET. Framework 2.0. In XP you will have to
ensure that you have upgraded your Framework version from 1.1 to 2.0

Proxy Setting
If the software is being accessed from behind a proxy you will need to open the
following ports

1) 10116 2) 25002

Browser version
IE 6/1IE 7 and other popular browsers including Mozilla and Chrome

Hardware
Pentium/Celeron Processor with RAM - 256Mb. Ideally 512Mb and above.
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Login

For logging on to your trading account, follow these simple steps:

* In order to logon to the EXE version, the web version or through your mobile,
you will be prompted to enter your Client ID and password.

¢ For the Web version, in addition to the password, you also need to provide your
PAN card number or date of birth in the specified format.

TT Web Login

Client Id
Fassword

PAN/DOB 7
Gyt o) )

Product [Equity | 7

Forgot Passward Submit

"2 Tip: This 2-level security has been provided to enhance security of the terminal
and prevent unauthorized access.

¢ Ensure that you type your Client ID accurately. The system will get locked after 3
incorrect attempts

¢ Itis mandatory to change your password the first time you login. Your password
should be alphanumeric and of atleast 8 characters

*  On successful login, you are ready to use the Trader Terminal and trade @ lightning
fast speed

‘\9/3 Tip: Passwords must be changed every fortnight
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Menu Options

I DFL Trader Terminal 3.0.0.11 for Client Code = India Infoline Ltd, T a—

File  Market Reports My Account Links Tools Research Windows  Customer Service

Market

;

Under this option you can create your own market watch, buy and sell scrips, analyse
the market real time and view charts

Reports

-

This menu is very useful to customers as they can view pending, executed or cancelled
orders during the day, open and closed Positions and also view their holdings at a
glance

My Account

i

The features under My Account help you to track your portfolio, check your P/L
summary, view digital contract notes, bills, confirmation notes etc. You can also transfer
funds from your bank account to your trading account and vice versa.

Links

-

This menu directly links the Trader Terminal to the websites of major exchanges, SEBI,
RBYI, etc. You may also view IIFL Research by going to the IIFL Website

Research

F

This provides you with research reports along with daily/weekly trading calls for buying
and selling of equities, commodities and also mutual funds.
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Features you might often use

Market Watch

Market Watch is a window which enables you to view market information of pre-
selected scrips of your interest. Trader Terminal allows you to create and open multiple
Market Watch windows to help you view real-time scrip details on the sectors/ scrips
of your choice simultaneously. You have the option of selecting stocks from the default
lists or to create your own customized list.

Creating a market watch
*  Go to Market > Market Watch > New or Press F4 on the screen

¢ Toload any of the pre-defined Market Watch, right click on the screen and select
Load group

¢ Select Predefined i.e. click on the + sign
¢ Double click on the desired option and the market watch would open
Adding scrips to the market watch

*  Goto the Add Scrip option on top of the window and type the name of the scrip
in the Code/Symbol block. Press enter key.

¢ The scrip will appear in the Market watch
Saving your market watch
*  Press Ctrl-S and save your Market Watch under a name

‘\9/3 Tip: Always export the saved market watch to a desired folder on your computer.
This can be done by right clicking the Market Watch and going to the Export Scrip
List Option
Each scrip makes up a row of data that contains the scrip name, its last traded
price, last traded quantity, best bid rate, best offer rate, total volume, etc.
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The market watch screen appears as follows in the different versions:-

e EXE Screen
\n; S G . - W =1oe ]
Scrip Name
Real Time

Price Updates

Click to view
scrip charts

Add Scrip

14.55
-2.80 (-2.39%)
vor

Real Time
Price Updates

Click here to load chart

Customizing the Market Watch

The order of the columns can be decided to suit one's convenience. To move a column
to the right or left, place the mouse pointer on the column heading and drag it to the
place of your choice.

You can also add/remove columns of your choice. To do so, go to Tools > Settings >

Market Watch.

Simply check the columns you would like to see the in the Market Watch, and uncheck
the ones you want to hide.
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Market Depth

Market Depth is a special feature of Trader Terminal.
Market Depth details the following features:

*  Real time scrip details
*  View Best 5 Bid/Ask and Open Interest

¢ Check DPR: Daily Price Range - 52 Week High
and 52 Week Low

¢ Check ATP (Average Traded Price)

¢ The intra-day chart shows daily real time price-
volume data for a particular scrip

Accessing Market Depth

To view Market Depth, double click on the scrip on
your Market Watch. The Market Depth window will
open.

IIFL

114.55
-2.80 (-2.39%)

HDFC LTD WARRANTS

Last Trade @ 114.55 BUY
Best 5 Bids Best 5 Asks

#| ay Rata aty Rate | #
1 1850 11430 1850 11475 1
1| 1850 114.25 1850  114.80) 1
1| 1850 114.20 1850|  114.85) 1
2| 3700 114.10 azo0|  115.00) 1
1| 1850 114.00 1850|  115.50) 1

Tot Bid Oty |undefined undefined Tot Ask Oty

Open 116.05 High 117.00 Total Qty. 98050

PClose 117.35 Low 114.00 Avg. Rate undefined

3 IIFL | —rriDERTE

Scrip Detail

476.10
+0.90 (0.92%)

TVS Motor Company Limited

Best 5 Bids

# | Qty Rate
1 500 425.00
2 290 415.00
13 120 475.00
4 980 445.00
5 200 485.00

Buy
(. Sell
Best 5 Asks

Qty. Rate #
270 42000 | 4
100 410.00 |12
210 430.00 | &
540 460.00 | 2
210 478.00 | 8

Total Bid Qty. 23950 | Total Bid Qty: 344250

T3 (DE/? Manual



IIFL

Market Analyser

Market Analyser is a unique feature which displays the current situation of the markets.
This window provides the information on Top traded, Top gainers and Top losers.

It also provides a list of scrips that have touched their 52 week high or 52 week low:.
You may view the Market Analyser on Markets > Market Analyser.

52 Week Top Gainers/
High/ Low Losers

TFL Trader Terminal 3, Code ol
Fle Mot Repors G 05062011 PUI0256:45
‘ sp ity 50470 16
adaserp> (152 <) (Eamy 7
| NEEEEmE SN T o romay
||| Market Analysis Equity (Sousée: Market ==
| Action Watch | 52wk High 520k Low Top Traded Top Gainers Toplosss | TradedOty | Traded Vae |
L}El E  Token Symbol Previous Close Currert Rate Change %loss 4
C | 2285 [ANTGRAPHIC 0.25 020 005 2000 |
N (C | 2972 PARASPETRO 055 045 0.10 18.18
N C | 3734 |INGVYSYABK 365.00 300.00 £5.00 1781
N |C | 16859 | RESURGERE 035 030 005 1439 |
NC | Tie2|aTL €875 £0.35 £.40 1222
N €| 1940 | KRISHNAENG 405 365 0.40 288 I
N |C | 3912 |KHAITANLTD 2690 2440 250 329 i
N _C | 7529 LCCINFOTEC 055 050 005 203 1=
N_c | 17002 | PRETAILDVR 191.20 175.00 16.20 847 |
N C | 25136 |BROOKS 3660 3355 305 833 |
N |C | 17883 |FTFTF128DV 575 9.00| 075 763
N [C | 11387 ici 5.85 9.10 075 751 ]
N €| 13511 | MUNJALAU 17565 163.00 265 7.20
N |C | 14365 | EVINIX 070 065 005 714 |
N [C | 2109 MANGTIMBER 1785 1650 EFS 7.00
N (€ | 11681 IMPEXFERRO 820 755 055 671 ‘
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BUY Order and SELL Otrder

In the Trader Terminal, you have multiple options to buy and sell scrips. You can use
any one of the following options to buy/sell a sctip:-

*  Click the 'Buy'/'Sell' button available in each Market Watch.
*  Right click on the sctip in your Market Watch, select Buy/Sell
*  You may alternatively go to Market > Buy/ Sell.

¢ While using the EXE version you can also use the shortcut keys - F1 for Buy and
F2 for Sell.

Performing any one of the actions mentioned above opens a Buy/Sell window. The
window provides options for placing a Market Order, Limit Order or a Stop Loss
Order

[~ Tip: Please refer to FAQ's section to know more about the type of orders

Global window for all products - This window lets you buy and sell products across
Cash, Futures, Options, Commodity, Currency or Mutual Funds.

On placing the buy or sell orders, you will get an instant confirmation on acceptance of
your order. These reports will also be available in your trade book.

EXE Screen Mobile Screen
655.00 Place Buy Order
-3.30 (-0.50% )
WorC LD Type @D
Last Trade 231@ Rs655.00 0032620
Best§BIDS 56 A Exchange NSE ©@BSE
¥ ay i #
0 Order Type  (Reguariot B
Scrip (
Series =B
4.95 Total Qty. © )
-3.35 (-0.51% ) Price O )
AERECD) 0 arket p
ity manmuns Thgger rce
— 700 22 DisclosedQty. (3
il
1 Validity (1 ]
Tot

(_Piace ) (_Cancel )

@ Call & Trade 0:
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AMO (After Market Order) Buy and sell

Now you can initiate a Buy/Sell order even after market hours. The order will be
processed on the next working day.

To place an AMO, go to Market > After Market Order > Buy/Sell.
Alternatively, you can use the following shortcut keys:

¢ For AMO Buy: Ctrl + F1

* For AMO Sell: Ctr]l + F2

Exe Screen

Place Buy Order for after hour E
Buy - Twe[Euy -] 430.00
Exchange © NSE () BSE +1.90 (044% )
Symbal RELCAPITAL RELIANCE CAPITAL LTD
T Code  |2882 ¢ LastTrade 104@ Rs430.00 at 02:32:26
1 Best 5 BIDS Best 5 ASKS
Total Gty 0 Price 0.00 # Qty Rate Rate Qty #
Order Type AL = 0.00 1 50 42080 429.90 40 2
G 1 100 42970 42905 131 1
Dis. Qty 0 1 2 42965 43000 350 2
1 10 42960  430.05 74 3
valigty  [DAY  ~ Pro/Cii  |CLI 1 200 42055  430.10 45 2
[ Poce ] [ cose Total Qty: 1,75,394 Total Qty: 2,33,182
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Option Calculator

Option calculator can be used to calculate the price of options. It can also be used to
calculate the following :-

¢ The value of put and call options (The Black-Scholes Option Pricing Model)

¢ The implied volatility

* Probability of the underlying security reaching the target price

¢ Key statistics for analyzing option positions in the market

To access the Options calculator, click on the 'Option Calculator' in Market menu

Exe Screen

-

Black-5choles Option Price Calculater
Share Price (Rs)

Strike Price (Rs) Call Value (Rs)

Time to Expiration (days)
Annual Interest Rate (%) Put Value (Rs)

Volatility (%)
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Reports

IIFL Trader Terminal generates several reports to assist customers to obtain a complete
view of their portfolio and transactions. These reports have the following features:

*  View order status

*  Modify cancel orders from Order Book

¢ Cancelall orders on a single click

¢ Square off open positions from Net Position window

*  Exercise long open option positions from the Net Position window
¢ Directly sell from Holdings window

*  View Matgins utilized/ available

¢ Sortall reports by any column

¢ Exportall reports individually or together on a single click

Order Book
Shortcut Key: F3

All pending orders can be seen in Order Book in the Reports menu option. You can
modify/cancel any or all pending orders at the click of a button. The order book also
has all other details like time and price the order was executed.

Reports

| Orders

Trades Net Postions |

Margin

| Activity Log

Holdings

E=8 [B=B S8

E. E. ScripCo...

508486

B

N

B 505036
B

N 5831
.

Name B...

TTKPRESTIG s
HAVELLS

Qy A..
100 N

GAYAPROJ
SIEMENS
SIEMENS

ACGL
ABB
ACGL
HAWKINS
SINTEX

Rate Wi..
1525.... N

375.10 N
850.00 N
875.00 N

350.10 |N

Trigg...

e

Trad...

AvgT.. Status

0.00 Pending
0.00 Pending

100
100

185 375.10 Fully Exect o

o
1]

0.00 Pending
0.00 Pending

0.00 Pending
0.00 Pending
0.00 Pending
0.00 Pending

100
100

250
100
250
100
500

Broker Ord... Exchange Orderi|
318440403 201011236729730
318313904 201011230005990

318313219
318313029 201011236671089
318312984 20101123667 1063

2200007200449

318312976 1100006800540
318312909 201011230005303
318312882 1400007000574
318312875 2100007100329
318312869 201011236670994
r

Order Status

Exchangs ent
Besh | [ Wosy | [ Cancd | [ Caceldl || Seve
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Trade book
Shortcut Key: F8

The Trade book shows all the details pertaining to the trades executed by you. The
trade book can be sorted on any of the columns therein.

Reports oo s
| Orders Trades NetPostions |  Magn | Activity Log Holdings
E. E ScipCode MName BuySell Qty Rate Exchange OrderlD Exch TradelD  Trade Time Trade Type
C |3546 TTKPRESTIG B 80| 1500.10 2010112366707705 BEG72816 | 09-15-31 A 23/ | Online
N _|C | 3546 TTKPRESTIG B 5| 1500.10 201011 2366707705 BEG73683 | 09-15-35 A 23/ | Online
N _|C | 3546 TTKPRESTIG B 5| 1500.10 2010112366707705 BEG75312 | 03-15-44 A 23/ | Online
N _|C | 3546 TTKPRESTIG B 10 1500.10 201011 2366707705 BEG75753 | 09-15-46 A 23/ | Online
B |C 532767 | GAYAFROJ E 186 37510 2200007 2004457 1084 | 125726 PM 23/... | Online
EE TTKFRESTIE  |B 5| 160010  2010112366707705 £E673689 | 0915.35 AM 23/... | Online
EETS TTKFRESTIE  |B 5| 1600.10]  2010112866707705 BEE75312| 091544 AM 23/... | Online
MEETS TTKFRESTIE | 10| 1600.10]  2010112366707705 BEE75753 | 091545 4M 23/... | Online
B |C |532767 GAYAPROJ B 185| 37510 2200007200437 1084 | 12-57-26 Pt 23/ | Online.
Exchange  Instrument
=

Margin
Shortcut Key: I'11

The Margin window shows you the real-time status of your Margins including margin
blocked for open positions and pending orders.

Reports =30 )

Orders I Trades I MNet Positions | Margin | Activitly Log I Holdings |

Equity Margin Description Amount Commaodity Margin Description Amount
| || Ledasr Balance
| Uncleared Cheques | | Uncleared Cheques
| Undelivered Value | Undelivered Value
| Mo delivery Debit | | Mo delivery Debit
| Options MtoM Loss | Options MtoM Loss )
| Adiusted Ledoer Balance(ALB) | Adjusted Ledger Balance(ALB)

| Cash received from customer | | Cash received from customer
| Cash pavout done to customer | h payout done to customer
ional Limits given

Additional Limits given

| Adiusted Holdings Value {AHV) Bedinning Of Day (BoD} | | Adiusted Holdings Value (AHV) Beginning Of Day (BoD) |
| Gross Margin i | Gross Margin ) ) |
| Mark To Market (MTM) profit/ loss on open postions | | Mark To Market (MTM) profit/ loss on open positions

| Margin Blocked for Pending Orders | | Marain Blocked for Pending Orders

Available margin for trading | Available margin for trading
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Net Position
Shortcut Key: F7

The Net Position gives you real-time marked to market profit and loss report on your
trades for the day. It shows realized as well as unrealized profit or loss for your trades
for the day. You can square off your open positions for the day with a single click using
the 'square off' button.

Reports =[-8 @

[ Orders i Trades Net Positions Margin i Activitiy Log i Holdings |
E. E ScipCode Name P.lT. BuyQty AvgBu Buy Val Sell Gty  Avg Sel Sell Value Net Qty Booked MtmPL  Current
LMC |11012 | QPTOCIRCUI D.N 10 23440 2344 0 0.00 0 10 0.00 -900| 23350
N |C 11373 BIOCON D..N 0 0.00 0 10 33855 3386 -10 0.00 -8.00 339.35
N |C |11483 LT D.N 5| 1,570.00 7,850 0 0.00 0 5 0.00 -55.00| 1,559.00
N_|C |11868 FINANTECH D. N 10 877.50 8,775 10 881.00 82810 0 35.00 0.00| 89355
N |C [1333 HDFCBANK D..N 7 491,14 3438 7 495.77 3470 0 3240 0.00 49450
N |[C [1594 INFY D..N 9| 243%00 21924 7| 245410 17179 2 126.70 070 243565
N_|C |17272 SBIGETS D.[N 4| 277500 11,100 4| 278220 11,129 0 23.80 0.00| 2779.60
N [C [2277 MRF D.. [N 12| 705467 84,656 2| 709650 14,183 10 8367 | -496.67| 7.005.00
N |C [3506 TITAN D..N 0 0.00 0 20 23362 58.405 -250 000 -53250 23575
N [C CORPEANK D.. N 10 0 0.00 0 433.50
Exchange Instrument  Client Code

v o -]

Holdings

Shortcut Key: F12

Press F12 on your EXE screen and get details of all your holdings in your demat
account as on the last working day. The Holdings Window also gives details on the
bought and sold quantity during the day. You can directly square-off your position in
particular scrip by clicking the 'Square Off button.

Reports == e )
|  Owes |  Tedes | MetPosiions |  Magin | Aciiiylog |  Holdings |
| Holding For : [ Equty -
Bse Code NseCode  Name “H. BODGy Bought. SoldQty NetOly SauareOF.. SquareOf. | Vake | BSERate NSERate lrfor.
| 523004 10| ABAN A 2] o o [ BsE NSE o]  omw| @
526173 U ANDREWYU 7 114 o ] 14| BsE NSE 0|  om| @
500013 148 | ANSALAPI L2 48 0 0 48 BSE NSE 0. DD. 0.00 i =l
500028 0|ATVPR z 143 0 0 143[_Bse NSE w| | G | =
512523 11373 | BIOCON A 10 0 10 o[ ese NSE w| | @ | =
532173 5154 | CORPBANK B 60| 10 o [ _Bsse NSE | ow| @ | =&
500094 0 CTCOTTON z 300 0 0 300 BSE NSE 0.00 0.00 i &
512180 11359 DHANBANK  |C 20 0 0 e[ ese NSE w| | G | =
500144] 1038 FINCABLES o 5 o 0| 45 ssE NSE | o @ | B
532183, 0 GAYATRI z 655 | of o e[ Bse ][ nee T | ow @ | e-
< [ L3
Cash Short Vakue - 0 Cash Long Value : 0 N T AN 100 T 5ot Fotes | [Tot Rows 230
F0 Short Valus * 0 F40 Long Vaue © 0 Total Holding Value © 0 ([ BsmaiDP Do |
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Save to Excel

You can save the data from all crucial reports to an excel file by clicking on the 'Save'
tab under each report. These will not only help in analyzing the information later but

also help keep a record.
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My ledger and DP

You can view your ledger account under the My Accounts menu option. In this window,
you can also view details of each bill, each transaction and the balance of your Cash
and F&O ledger.

To access the ledger account, go to My Account > Ledger. Select the period and
product for which you wish to see the ledger, and click the 'Show' button.

Holders of a depository account with IIFL can view online all their holdings and
transactions in their beneficiary account under the DP option in My Accounts menu.

Date Range
TFL Trader Terminal(Beta) 3.00.13 for Online Client Code - CYBER0OO : India Infoline Ltd. -8 x|
Fle Market Repors Myhccount Links Took Ressrch Windows CustoerServe 09082012 PM 40101

SPCNX Nifty 5322.95 0.00 || Sensex 17560.87 0.00

Adasorip>oWSE =] [Eay | =] =

Ledger
Ledger
From (100772012 [E To [po/os/20i2 =]
Products [Equity/Currency A © NSE CASH " BSE CASH © NSEF&O
Exchange
 BSEF&0  NSE CURENCY © mex sx
Show
Date Particular Voucher | Debit | Credit | alance
10/07/2012 Opening Balance 0000000 20000
05/08/2012 _ BEING TRANSACTION CHARGED ON EQUITY SIP N7 1000 000 3000Dr
Total Uncleared Balance: 0 1000 000 30800r

Downioas = B pint

T e
fe0z:22 P

Confirmations 7] [Market News

[ confirmaticns essages  Dow Jones essages (Co. essag quity Ca TRl Market News

‘SEBI Regn ot INB231097537 ENF231057537 INEZ3107537. NSE Cod ot 10575 ING OLLOSYSS3 BSE CODE : 179 | MCX CODE ; 10470 | NCDEX CODE No. NCDEX.CO-D400378 | MOX X CDDE No.1022

Ledger

Download Multiple Product
summary

Excel/pdf Option
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Fund Transfer

You can easily transfer funds online to and from your bank to your trading account
using the Funds transfer option under the My Accounts menu.

¢ To transfer funds to your trading account, use the Fund Pay In option, wherein you
will be directed to the respective bank website

¢ To withdraw funds from your trading account, use the Fund Pay Out option. Fill
in the requisite details and click 'Pay Out'

Fund Pay-in Payment

Fund Pay-out
Mode

[ Yo
022 39440000

IIFL | —=»/DErR7E e SWAT on § a | Help

Equity Market Reports  MyAccount Research  CustomerSenice
Fund Transfer
Customer I PCSWATIS
Adjusted Lddger Balance (Equity) 8100
Fund Pay In Payln History Fund Pay Out Pay Out History

Product

[Eauity/Cirency -]

Product

Equity/Currency ]

Bank [SelectBark =] Amount [0 (AvailableBalance 915,00 ) ~
Amownt Paylode [Electronic Fund Transfer | ~|
Payin aax [ICICIBANK LTD—>001601034276 =|
Remark |

Pay Out

* ALB- Adjusted Ledger Balance. Amount mentioned is the current ledger balance in your IFL account

** Available Balance - Amount mentioned is available for Payout after adjusting min balance of Rs. 1000 in your IFL account

Note:
Clientfunds payoutwill be transferred online to your bank account ONLY through NEFTIRTGS.

Please note if your bank account IFSC code is not updated with us (which is mandatory for NEFT/RTGS transfers), funds payout will not be processed online for all
your fund payout request

We request you to kindly update your IFSC code forthe bank account's registered with us latest by April 25,2012, You can update your IFSC code by submitting a
hard copy or scan copy of cancelled cheque of the registered bank account ither at your nearest branch

For any dlarifications or assistance you can email us at cs@indiainfoline.com or reach our customer care desk at (022) 40071000 o at our zonal customer senvice
numbers:North 011-49315020, East “033-44048600, Maharashira-022-40609292, Gujarat and Madhya Pradesh 079-40271800, South-080-40547030

SEBIRegn No: INB231087537 & NF231007537 AboutUs | indianfoine.com | Privacy Polcy | Disclaimer | NSE | BSE | SEBI | REl

NSE Code No: 10375 & ING 011087533 BSE CODE * 179 © Copyrignt inds Infoline Lid. Al righs reserved.

i Secured by @thawte
B ik o
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Charts

Charts are a unique and useful feature in IIFL Trader Terminal. To view the chart for
a scrip, select the scrip in Market Watch, then select Chart option in the Market menu.

The features of the Charts tool available in Trader Terminal are:

¢ Streaming intraday tick-by-tick charts

¢ Historical Charts (1m, 3m, 6m, 1y, 2y, 5y, etc)

¢ Ability to chart multiple companies and open unlimited charts simultaneously
¢ Unique draw tools including trend line customization and Fibonacci tools

¢ 3different chart type options such as Line, OHLC and Candlestick

¢ See each tick in Excel type grid, which is updated real-time. Also export to
CSV file

¢ GetIndex charts by clicking on appropriate Index in the Index Watch window

Chart in EXE version

LFL Trader Terminal 30010 for Cient Code = Indi Infoin Lt Lo 1

Fie Vam Repots Mybeeoum Uiis Tooh Resewch Windows  Csmersenin 006 00 PGzsed

Intra-Day/
Historical charts

Indicators
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There are multiple analysis options available including 14 indicators for price and volume
panels which can be accessed by right clicking on the chart screen.

Indicators available in Charts

1. Moving Averages 8. Exponential Moving Average
2. Weighted Moving Average 9. MACD

3. Bollinger Bands 10. Price Rate of Change

4. Relative Strength Index 11. Stochastics Oscillator

5. Average True Range 12. Momentum

6. Money Flow Index 13. On Balance Volume

7. Standard Deviation 14. Williams R
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Research

The Trader Terminal gives you access to world-class research. IIFL research has been
acknowledged by Forbes as 'Best of the web'and a '...a must read for investors'. You
can view company research, interviews with Industry stalwarts, analyst reports, news,
annual reports and quarterly reports on the Trader Terminal.

Our experienced team of research analysts also provides you with intra-day ideas in the
cash and derivatives segment to help you stay ahead of the market. You also receive
market news throughout the day to keep you up-to-date on the various developments
in the market.

Market Mantra Market Mantra
Market Mantra is IIFL's daily
comprehensive research product which

Daily Archives ‘
11-Jan-11
10-Jan-11 |

07-Jan-11

i | covers market outlook, latest news,
04-Jan-11 .
oy | economy snapshot, personal finance
it |
24-Dec-10
23-Dec-10

insights, event notes, management meets

and research ideas for Equities, Derivatives
and Commodities

Weekly Wrap
IIFL Weekly Wrap comprises actionable Wookly Wrap
Ideas, Market Outlook, Commodity | rarsuaem A

Long Axis Bank & Short Bank Nifty

Corner, Mutual Fund section, Event
Calendar and a comprehensive Chart book.
It also includes charts on Nifty Futures
VWAP and Bank Nifty Futures VWAP.

*(8962/1000-8.962 - price rato)
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ITFL Calls
IIFL Calls gives you intra-day ideas in the cash, derivatives and commodities segment
to help you stay ahead of the market.

An alert pops up and prompts you to check if any updates are there.
IIFL Commadity Mantra

Base Metals Update - August 2011 Global Update

INDIA PRIVATE CLIENTS

Macro Variables portraying gloomy economic backdrop

Comex Gold (April) Comex CMP: USS$ 1,433.4/0z
A AR L 3

Fundamental View: Safe-haven investment
en ues

crises continuing to produce safe demand g
for the metals. w alf n
I i, w
Gold on the Comex division of the New York U T i
Mercantile Exchange ral ime. L "
of $1,448.60 per w
4 i
- n th and L]
Nor a (Mena) region have also helped ==
09 W09 M09 Apr10 Sep10 Fob 11 4b11 atos oi0s s an main Same. v of Sofe-hoven demmand o WM
Source: Bloomberg, 1nda Infoline Research gold !
———ee—————
Industrial Production(yoy): Stagnating Vehicle Sales: Impetus missing Gold“futures: ‘stendied near: record highsias® DRt i
0] —dopan — e — —Garorore | —bpan— Cova— U5 —rpe investors remained jittery about European debt, L T+ ET T T v T

Price Alerts

You can set price alerts for as many scrips as you wish using this feature. These alerts are
triggered and are designed to remind you of certain benchmarks that you can set as per
your requirements. It alerts the trader when the scrips run more than or less than a
particular value, so that the trader can instantly buy or sell it.

The following screenshot shows the window where you can set the price alerts.

Scrip name for which

e a0 o b g Set the trigger rate for

the price alert

'rice Alert =

Serip Scrip List Rate : @ »= () <=
Message :
[ A |

Exch Code Mame Indicator Rate Time: Message
N | 10 | ABAN <= 1000 [ 14-Sep-2... [ ABAN hitting less than 1000
N 11536 | TCS | 2= | 1500 | 14-5ep-2... | TCS hitting grester than 1500
N | 17398 | HDFC | 5= | 700 | 14-Sep-2... | HDFC hitting greaterthan 700
Enter message to be displayed Scrip for which price alerts
in the pop-up window have been set
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Portfolio

You can view your portfolio under the My Account menu option.

Portfolio Tracker
The Portfolio Tracker menu option tracks all your investments, cash flow and assets.

P/L summary
Your notional profit/loss is shown by marking total purchase/sales to the current
market value of your securities. Cash and Derivatives segments are shown separately.

Portfolio

Tracker
P/L Summary
TFL Trader Termpnal 20010 for Chent Code Indi Infolne L. )
Fie Mokt [epots My Toos Reserch  Windows _ Cusame Servee 0006 2011 V02564
spoukity ss}s20 365 535080 340
naaserp>> [NEE <] [Eany =1l
— P/L Summary. =5 Eou
Portfolio Tracker i
P/L Summary
ClkHere forExtemalDp Transer Eat
GlckHere forxtemalDp Transter Eat
prouet  Cash
From l01/04/2008 = To 09/06/2011 B
From 10/05/2011 [E To [10/06/2011 B S
=
ell value of
SecurtyName | BuyQly.| BuyAvgRate| BuyValue | Prvclose | MarketValue oM diniaRostonite stock
> T 3 w0 wowom o o)
Securi By, Buy Sl Sell Lon, Short
> ane w B es0 o w  asem D I P
>  ABBSE 0 17638 8284400 000 0.00 (8,844.00) Bate: ke
TISDHALSH 15 %21 953375 000 000 ©.53375) 2 ToTAL — L
ORTIS 12 14000 15,680.00 0.00 0.00 (15,680.00) ¥ QEENING;
s St Opbg At O
s . g e ay e D
Downioza EB et B
Securities in
> T 20 500 w00 s
Portfolio s W ms e seam
> nses o w0 ssus seam
> TsomsH s 2 osmas seam
/ > CORTIS 112 14000 1568000 5/9/2011
Download SocuttyTTax 000
. ReguatoryCharges 000
options |
Buy value of
portfolio
Security Buy value of
Name stock
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Lock/Unlock your Trading Terminal

To ensure secutity of your account/terminal, an option of locking the terminal has
been provided to prevent it from being misued. Locking your terminal disables the
trading feature. The application will however, keep receiving broadcast and other
messages. The display will keep updating itself accordingly.

The terminal auto locks itself after 10 minutes of inactivity. This period can be
modified by you.

To lock the terminal manually, go to File > Lock

T3 (DE/? Manual



IIFL

Do's & Don'ts while trading on ITFL Trader Terminal

Do's
1. Change your Passwords every 14 days.
Keep your Internet Trading Passwords Confidential.

2

3. Clear your browser's cache regularly

4. Disable the "Auto Complete" function on your browser
5

Discard pin or password mailers immediately after memorizing them. Never write
them down.
Don'ts

1. Do notdirectly close your browser after you complete your online Trading session.
Log Off from Trader Terminal before closing the browser.

2. Avoid downloading programs from unknown sources: Some sources may have
hidden forms of spyware or viruses that could compromise the security of your
computer.

Do not open attachments sent through mails, if you do not know the sender.

4. Never open email attachments that have file extensions like .exe, .pif, or .vbs. Such
files are usually dangerous.

5. Do notkeep computers online when not in use: Either shut the PC off or physically
disconnect it from the Internet connections.

6. Do not use shared computers: We recommend that you avoid accessing your
Trader Terminal from a public / shared computer, such as in a cyber cafe.
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FAQ's

1.

How to get your saved market watch when the Trader Terminal application
is updated?

Note that whenever the exe is updated the Market Watch groups saved by you
previously would not appear in the new exe. To retrieve your saved Market Watch,
follow the below procedure:

¢ Click F4. Right click and Go to the Import Scrip List option
¢ Import the list from the saved folder

¢ The saved Market Watch will open in the terminal

= Tip: In order to avoid losing your saved Market Watch, always export your Scrip

List on to your Computer.
What is PLM and how does it work?

PLM stands for Primary Login Machine. During first time login, client will be
asked to either restrict (bind) or do not restrict the terminal to his system/computet.

To bind/restrict the terminal, you need to select the option "Restrict my id to this
machine". Please note once the terminal is restricted to a system you will not be
allowed to login to terminal from another system or computer.

If do not wish to restrict or bind the terminal, you need to select the option "Do
not restrict my ID to this machine". Please note if you do not restrict the terminal
you can operate the terminal from any system or computer

Note: If you have restricted your terminal to a system and wish to operate the
terminal from another system, you need to go to => Tools => Reset PLM/
Binding before logging out from the terminal. If you are unable to follow these
instructions due to unavailability of the same system/computer you may call our
Customer Service on 022-40071000 to unbind the PLM

What is the procedure for receiving password to login to terminal?

In case you have forgotten your password you can place fresh password request

online.
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Click on terminal icon

Select Forgot Password on the login window
Verify credentials

Submit

Note: Password will be sent to you on your registered mobile number. You are
requested to change your password within 72 hours else password will be expired.
In case you are unable to request for password online you may call our Customer
Service on 022-40071000 to place your request.

What if you enter wrong password three or more times?

If you enter incorrect password three or more than three times your account will
be locked and you will get a message window stating "Too many attempts". Please
note that your account will automatically be released in 15 mins and you will be
allowed to operate your account

Note: In case of urgency you may call our Customer Service on 022-40071000 to
unlock your account

What are the segments available while trading through terminal?

If your account is activated for online trading you can place orders in NSE and
BSE segment. To trade in F&O segment you need to submit written application
and income proofs for activating terminal in F&O segment

Note: If the required details are already submitted, by default your terminal will
be activated in F&O segment and you will be able to place F&O orders. In case
documents are not submitted and you try to place the orders, the same will be

rejected by exchange. To activate the same you may call our Customer Service on
022-40071000 for assistance

What are STOP LOSS orders?

Stop Loss order is a tool used to limit the maximum loss on a position. It allows
the client to place an order only when the market price of the relevant security
reaches or crosses a threshold price specified by the investor in form of 'Stop Loss
Trigger Price’
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Example:

Stop Loss BUY order

Suppose person A short sells Tata shares at Rs. 1150 with the expectation that the
price will fall. However, in the event that the price rises above his buy price, then A
would like to limit his losses. 'A" may place a limit BUY order specifying a stop loss
trigger price of Rs. 1200 and the limit price as Rs. 1210. The stop loss trigger price
(STLP) has to be between the last traded price and the BUY limit price. Once the
market price of TATA breaches the STLP (i.e. Rs. 1200), the order gets converted
to a limit BUY order at Rs. 1210.

Stop Loss SELL order

Suppose person A buys Tata shares at Rs. 1150 with the expectation that the price
will rise. However, in the event that the price falls, then A would like to limit his
losses. "A" may place a limit SELL order specifying a stop loss trigger price of Rs.
1130 and the limit price as Rs. 1120. The stop loss trigger price (STLP) has to be
between the last traded price and the SELL limit price. If the market rate reaches
the trigger price, the SELL stop loss order is triggered and it becomes a plain limit
order.

Points to Remember:

For placing a Sell stop loss order, both the rates must be lesser than market rates.

Trigger rate should be greater than or equal to limit rate, but it should never be
lesser than limit rate while placing Stop Loss order.

If the rate entered by you in the trigger rate comes in the market, your sell stop loss
order gets triggered and becomes a plain limit order.

What is a Frozen Order?

There is a certain price range for each scrip that is decided by the exchange. If the

order placed by you is not in a proper price range then the order gets frozen or
rejected.

A frozen order is not executed and you will have to place a fresh order for the
same.
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What is a Disclose Quantity (DQ) Order?

In a regular order, the market quantity is disclosed in full to the market. An order
with a DQ condition/attribute allows disclosure of only a part of the order quantity
to the market.

For example, an order of 2000 with a DQ condition of 200 will mean that 200 are
disclosed to the market at a time. After this is traded, another 200 is automatically
released and gets executed. DQ should not be less than 10% of the order quantity
and should not be greater than the order quantity.

What is the market time to place after market orders online?

You can place After Market Orders between 4.30 p.m. to 8.30 a.m. online through
terminal.

How do I view scrips which are newly listed?

For viewing a newly listed scrip in your Market watch, you need to download
Scrip master from file menu and then select that scrip from the add scrip window.

What do I do if the rates on my terminal are not refreshing?

If the rates on your terminal are not refreshing, try the following options:-

12.

Exit and re-login to the terminal.

Change the broadcast server from the file menu.

If the above options do not work, contact Customer Service.

Can I have more than one active Trader Terminals on the same Computer?

Yes. Itis possible to use more than one Trader Terminal on a PC, as long as you are
logged in with two different ID's
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Error messages and their meaning

Error Message Particulars

Sent to IIFL Indicates that the order may or may not have reached the
server. Hence, it is advisable to refresh the order book to
get the updated status

Rejected by RMS Indicates that order is rejected due to insufficient margins
available

Otder does notexist | Indicates that the order has already been executed and it
cannot be modified or cancelled

Rate not within Indicates that the rate at which order is placed is either

circuit limits too high or too low in comparison to the rate currently
prevailing in the market. Hence this order gets rejected.

Order value exceeds | You need to contact Customer Service

Invalid client type Indicates that your account is not active for online trading.

To activate your account for online trading you need to
contact Customer Service on 022-40071000

Note: It takes 24 working hours to activate your account
for online trading after the same is requested by you

Broker/Order id Indicates that the scrip master is not downloaded at the
not set time of release of upgraded version of Trader Terminal.
You need to update the scrip master by selecting the option
=> Master => Download Master
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TT Help Desk

We will always be happy to help you with any questions.

Please note our help desk contact details given below.
Call: (022) 4151 4151

Email: tt(@indiainfoline.com

Customer Care: cs@indiainfoline.com
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Products on Trader Terminal
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X paperwork
X multiple signatures

Mutual Fund trading
now made easy

Now you can invest in MF online

* Choose from 20 AMC’s and 1000 schemes

e All transactions get reflected in your demat account
* No additional KYC is required

e Simplified MF tracker especially for you

Trading in MF, just a click away! .

To open an account
Call: 4912239440000 | Write to us at: cs@indiainfoline.com
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Experience the Power of Multiplication
with Trader Multiple

Trader Multiple multiplies your buying power by giving you higher exposure
in specific stocks based on your available margin. It is an intraday product,
especially designed for smart investors who wish to take advantage of higher
trading margin.

Advantages of Trader Multiple:

 Traders can benefit from higher multiple on select stocks.

* Capitalise on research ideas and market opportunities using a higher multiple.
e Flexibility of placing a profit order and stop loss order at the same time.

e Limit your losses through stop loss order.

How to place a Trader Multiple order?

e Login to your trading platform entering existing login id and password.

e Click on Trader Multiple on the Market menu.

e Accept the terms and conditions to activate the Trader Multiple product.

* Select the Exchange, Scrip and Buy/Sell option.

e Put the desired quantity based on the margin available and place the order.
The orders in Trader Multiple are placed at Market Price by default. The
system will also place a stop loss order set at a difference of 4% from the
Market Price by default.
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Sl P*, for more money

Now invest in SIP through

ttweb.indiainfoline.com

and TT desktop

Benefits of SIP
* Rupee Cost Averaging

e Easy and flexible investment
e Very low monthly investment possible

¢ Reduces Market Risk

e Disciplined Investment

IIFL OFFERINGS

Equity SIP

Equity SIP allows you to
invest in a set of stocks
or exchange traded
funds at regular intervals
& beat market volatility
by averaging out the
costs.

e-Gold SIP *

Gold SIP's enable an
investor to invest in the
yellow metal in paper form
and save the investor the
hassles of storage. e-Gold
is more cost effective for
people who have a long
investment horizon.

e-Silver SIP *

Silver is the next most
traded commodity after
Gold. It is widely used in
industrial products and
thus raising the demand
for the metal.
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FEATURES
Investment Tenure
Product Min (in Rs.) Max (in Rs.) Min Max Quantity
Traded
Equity SIP 3000 Unlimited = 6 months 10 years | 1scrip
e-Gold SIP | Prevailing cost Unlimited = 6 months 10 years lgm
per lot
e-Silver SIP = Prevailing cost Unlimited 6 months 10 years = 100gms
per lot

How can you invest through SIP?
To start investing through SIP, you will have to follow 4 easy steps as mentioned

below:

e Login to your trading account

using Client ID and Password

TT Web Login

Client Id

Password

Product Equity j ?

Forgot Password Submit

e Fill the required details
Place Equity SIP Order -|

Invest By & Quantity © Amount

SIP Debitthrough @ Ledger

Add scrip » [NSE x| Add

SIP Total Amount (Rs.) 0
Order Type Product Type

Mo, =] SP instalment [g

SIP Frequency

SIP Start Date 10Nov2012 | SIPEndDate 10 Apr2013

(An additional amount of Rs. 10.00 will be charged as transaction charges per installment)
Note: SIP value will be subjected to the marketvalue of scrips on a transaction date + Rs. 10.00,

Place | [ Reset

Market Repors
Market Watch
Buy

Sell

Trader Multiple Order

After Market Order
Charts

¢ Click on the tab Market Product SIP

IPO I FPO / Bonds / NFO-MF

Mutual Funds

Mutual Funds SIP

Equity SIP
»

»

Indicative SPAN Margin

e Accept the Terms & Conditions and
place the order

Min. 6-Max: 120

*Note: e-Gold SIP & e-Silver SIP are traded through India Infoline Commodities Limited with NSEL.
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Tel: (91-22) 3929 4000/ 4103 5000 * Fax: (91-22) 2580 6654
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